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1.   Terminology For SAFE Method of Calculating Punching Shear

The following terms are used in describing the SAFE method of calculating punching shear:

b0 = perimeter of critical section for punching shear
d = effective depth at critical section for punching shear based on average of d for X

direction and d for Y direction
IXX = Moment of inertia of critical section for punching shear about an axis that is parallel to

the global X-axis
IYY = Moment of inertia of critical section for punching shear about an axis that is parallel to

the global Y-axis
IXY = Product of inertia of critical section for punching shear with respect to the X and Y

planes
L = Length of side of critical section for punching shear currently being considered
MUX = Moment about line parallel to X-axis at center of column (positive per right-hand rule)
MUY = Moment about line parallel to Y-axis at center of column (positive per right-hand rule)
vU = Punching shear stress
VU = Shear at center of column (positive upward)
x1, y1 = Coordinates of column centroid
x2, y2 = Coordinates of center of one side of critical section for punching shear
x3, y3 = Coordinates of centroid of critical section for punching shear
x4, y4 = Coordinates of location where you are calculating stress
γVX = Percent of MUX resisted by shear per ACI 318-95 equations 11-41 and 13-1
γVY = Percent of MUY resisted by shear per ACI 318-95 equations 11-41 and 13-1

2.   Basic Equations For SAFE Method of Calculating Punching Shear
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The equations for XYYYXX Iand,I,I  are different depending on whether the side of the critical
section for punching shear being considered is parallel to the X-axis or parallel to the Y-axis.
Refer to Figures 1a and 1b.
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Figure 1b:  Plan View For Side of Critical Section Parallel to Y-Axis
 Work This Sketch With Equations 5b, 6b and 7
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3.   Limitations of Punching Shear Calculations in SAFE

•  The shear and moment values used in the punching shear check have not been reduced by the
load (or reaction) that is included within the boundaries of the punching shear critical section.
Typically the effect of this simplification is small except in some cases for deep slabs (e.g.,
mat foundations) and slabs with closely spaced columns.

•  Punching shear is calculated for columns punching through a slab or a drop panel.  It is not
calculated for a drop panel punching through a slab.  The effect of column capitals is
included in the punching shear calculation.

•  The program checks that each slab element in the area enclosed between the face of the
column and the critical section for punching shear has identically the same slab property
label.  If so, the punching shear check is performed, if not, punching shear is not calculated
and N/C is displayed.

•  When line objects (beams, walls or releases) frame into a column, punching shear is not
calculated and N/C is displayed.

•  If a point load or column falls (call it load/column A) within the critical section for punching
shear for another point load or column (call it load/column B), then it is ignored in the
punching shear calculation (that is, the effect of load/column A is ignored when doing
punching shear calculations for load/column B.)

•  The program only considers critical sections for punching shear that have sides parallel to the
X and Y axes.  Thus when the edge of a slab is not parallel to the X or Y axis, the program
may not pick up the worst case critical section for punching shear.  For example, in Figure 2,
the critical sections for punching shear identified in Cases A and B are considered by SAFE,
but CASE C is not considered.
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X

Y

X
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Column
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punching shear
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Critical section for
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Column
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Not Considered by SAFE

Figure 2:  Critical Sections For Punching Shear Considered By SAFE
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4.   Other Comments

Equation 1 is based on Chapter 8, Section 50 of S. Timoshenko’s book titled “Strength of
Materials” (Ref. 1) and on the requirements of codes such as ACI 318-95.

For interior columns and edge columns the punching shear formulation used in SAFE yields the
same results as those that are obtained using the equations given in Figure 18-16 of the PCA
Publication (Ref 2).  The results are different for corner columns.  The reason for the difference
is the IXY term that is included in the SAFE equations but not in the PCA equations.  For interior
columns and edge columns the IXY term included in the SAFE formulation reduces to zero.  The
IXY term is nonzero for corner columns because the X and Y axes are not the principal axes for
this section.  If the IXY term in the SAFE equations is set to zero, then the SAFE equations yield
the same results for corner columns as the PCA equations.  (Note that there is no way to actually
set the IXY term to zero in SAFE.)  It could be argued that the SAFE formulation is perhaps more
theoretically sound than the equations given in the PCA Publication.  The net effect of the IXY
term is to make the SAFE punching shear calculation for corner columns a little more
conservative than that given in the PCA Publication.

5.   References

1. S. Timoshenko, 1958
Strength of Materials, Part I, 3rd Edition, D. Van Nostrand Company, New York, New
York.

2. PCA, 1996
Notes On ACI 318-95 Building Code Requirements For Structural Concrete With Design
Applications, Portland Cement Association, Skokie, Illinois.
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6.   Numerical Example

6a. Problem Statement

The numerical example is a flat slab with drop panels that has three 24' spans in each direction,
as shown in Figure 3.  The slab overhangs beyond the face of the column by 6" along each side
of the structure.  The columns are typically 12" x 36" with the long side parallel to the Y-axis.
The slab is typically 10" thick.  At the drop panels there is an additional 5" of slab thickness, thus
the total slab thickness at the drop panels is 15".  The plan dimensions of the interior drop panels
are 8' x 8', the edge drop panels where the edge is parallel to the X-axis are 8' x 6', the edge drop
panels where the edge is parallel to the Y-axis are 5' x 8', and the corner drop panels are 5' x 6'.

The concrete has a unit weight of 150 pcf and a f'c of 4000 psi. The dead load consists of the self
weight of the structure plus an additional 20 psf.  The live load is 80 psf.

Thick plate properties are used for the slab.

Each column in Figure 3 is referenced with a number.  For example, the column at the
intersection of grid lines A and 1 is number 5.  These numbers refer to the point object ID’s in
the associated SAFE model
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Figure 3:  Flat Slab With Drop Panels For Numerical Example
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6b. SAFE Computer Model

In SAFE it is easy to create a computer model for this example, analyze it, design it, and print
out the punching shear results.  The following steps are required:

1. Set the units to kips and feet.

2. From the File menu select New Model From Template, and then click on the Flat Slab
button to display the Flat Slab dialog box.

3. In this dialog box:

•  Change the Top Edge Distance and Bottom Edge Distance to 2.

•  Check the Create Live Load Patterns check box.

•  Accept the rest of the default values and click the OK button.

4. From the Define menu select Slab Properties to display the Support Properties dialog
box. Highlight the property named COL, click the Modify\Show Property button to
display the Slab Property Data dialog box, check the Thick Plate check box and click
OK. Highlight the property named DROP, click the Modify\Show Property button to
display the Slab Property Data dialog box, check the Thick Plate check box and click
OK. Highlight the property named SLAB, click the Modify\Show Property button to
display the Slab Property Data dialog box, check the Thick Plate check box and click OK
twice to exit all dialog boxes.

5. From the Define menu select Column Supports to display the Support Properties dialog
box. With the support property named COLUMN highlighted click the Modify\Show
Property button to display the Column Support Property Data dialog box. In this dialog
box change the Y Dimension to 3. Accept the rest of the default values and click the OK
button twice to exit all dialog boxes.

6. The SAFE model is now created and ready to run.  From the Analyze menu select Run
Analysis.  Select a directory and provide a name for the input file and then click the Save
button to proceed with the analysis.

7. When the analysis is completed review the messages in the Analysis window and click
the OK button.  The model is now ready for design.

8. From the Options menu select Preferences and click the Concrete tab.  Verify that the
Concrete Design Code selected is ACI 318-95.  If necessary, change the selection to this
code.  Click the OK button to exit this dialog box.

9. From the Design menu select Start Design.
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10. When the design is complete click Display Punching Shear Ratios on the display menu to
show the punching shear results graphically.

11. Change the units to kips and inches.

12. From the File menu select Print Design Tables to display the Design Tables dialog box.

13 In this dialog box:

•  In the Design Output area uncheck the Slab Strip Reinforcing check box and check
the Punching Shear check box.

•  In the Design Forces area uncheck the Slab Strip check box.

•  Check the Print To File check box.  Note that the default name for this file is the
name of your model with a .txt extension.  Accept this default name.

•  Click the OK button to create the punching shear output.

The punching shear output is now in a text file whose name is the same as your input file with
the extension .txt.  You can open this text file in any text editor or word processor, or you can
use the Display Input/Output Text Files feature on the File menu in SAFE to open it.  This
feature opens the file in Wordpad, a text editor that is supplied with Windows.  If you open this
text file in a word processor or a spreadsheet it should look similar to that shown in Figure 4.

SAFE v6.14 File: PUNCHEX Kip-in Units PAGE 1
November 14,1998 7:59

P U N C H I N G S H E A R S T R E S S C H E C K

POINT X Y RATIO COMBO VMAX VCAP V MX MY DEPTH PERIM LOC

5 0.00 0.00 1.000 DCON2 0.179 0.179 -54.696 -1962 1145.680 13.500 73.500 C
6 288.00 0.00 0.802 DCON2 0.144 0.179 -119.738 -3778 -348.558 13.500 123.000 E
7 576.00 0.00 0.802 DCON2 0.144 0.179 -119.738 -3778 348.558 13.500 123.000 E
8 864.00 0.00 1.000 DCON2 0.179 0.179 -54.696 -1962 -1146 13.500 73.500 C
9 0.00 288.00 0.515 DCON2 0.092 0.179 -94.860 174.953 1463.801 13.500 99.000 E

10 288.00 288.00 0.702 DCON2 0.126 0.179 -225.707 464.658 -419.712 13.500 150.000 I
11 576.00 288.00 0.702 DCON2 0.126 0.179 -225.707 464.658 419.712 13.500 150.000 I
12 864.00 288.00 0.515 DCON2 0.092 0.179 -94.860 174.953 -1464 13.500 99.000 E
13 0.00 576.00 0.515 DCON2 0.092 0.179 -94.860 -174.953 1463.801 13.500 99.000 E
14 288.00 576.00 0.702 DCON2 0.126 0.179 -225.707 -464.658 -419.712 13.500 150.000 I
15 576.00 576.00 0.702 DCON2 0.126 0.179 -225.707 -464.658 419.712 13.500 150.000 I
16 864.00 576.00 0.515 DCON2 0.092 0.179 -94.860 -174.953 -1464 13.500 99.000 E
17 0.00 864.00 1.000 DCON2 0.179 0.179 -54.696 1962.206 1145.680 13.500 73.500 C
18 288.00 864.00 0.802 DCON2 0.144 0.179 -119.738 3777.943 -348.558 13.500 123.000 E
19 576.00 864.00 0.802 DCON2 0.144 0.179 -119.738 3777.943 348.558 13.500 123.000 E
20 864.00 864.00 1.000 DCON2 0.179 0.179 -54.696 1962.206 -1146 13.500 73.500 C

Figure 4: SAFE Output For Punching Shear

Following are explanations of each of the column headings in the output shown in Figure 4:

POINT = SAFE point object ID at location where punching shear stress is reported
X = X-coordinate of POINT
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Y = Y-coordinate of POINT
RATIO = Punching shear stress divided by punching shear capacity
COMBO = Load combination that produces maximum punching shear stress
VMAX = Punching shear stress with the maximum absolute value
VCAP = Punching shear stress capacity with a phi factor included, i.e., φvC
V = Shear used in punching shear stress calculation
MX = Moment about a line through the column centroid and parallel to the X-axis used in

punching shear stress calculation
MY = Moment about a line through the column centroid and parallel to the Y-axis used in

punching shear stress calculation
DEPTH = Effective depth for punching shear calculated as the average of the effective depths

in the X and Y directions
PERIM = Perimeter length of critical section for punching shear
LOC = Identifier for column location: I is an interior column, E is an edge column, and C is

a corner column

We will now derive some of the results shown in Figure 4 using hand calculations.  The results
we will calculate are the shear stress, shear capacity and the shear ratio for an interior column, an
edge column with the edge parallel to the X-axis, an edge column with the edge parallel to the Y-
axis, and a corner column.  We will calculate these values using the SAFE formulation and then
calculate them again using the formulation in the PCA Publication (Ref 2).  Finally, we will
compare the results obtained from SAFE, our hand calculations using the SAFE formulation, and
our hand calculations using the PCA Publication formulation.

6c. Hand Calculation For Interior Column Using SAFE Method

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

Refer to Figure 5.
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Figure 5:  Interior Column, Point 10 in SAFE Model
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The following table is used for calculating the centroid of the critical section for punching shear.
Side 1 , Side 2, Side 3 and Side 4 refer to the sides of the critical section for punching shear as
identified in Figure 5.

3 =x

3 =y

The f
given

From

VU =
MUX
MUY

At th

Pa
E

Item Side 1 Side 2 Side 3 Side 4 Sum
x2 -12.75 0 12.75 0 N.A.
y2 0 24.75 0 -24.75 N.A.
L 49.5 25.5 49.5 25.5 b0 = 150
d 13.5 13.5 13.5 13.5 N.A.

Ld 668.25 344.25 668.25 344.25 2025
Ldx2 -8520.19 0 8520.19 0 0
Ldy2 0 8520.19 0 -8520.19 0
"0
2025

02
==�

Ld
Ldx

"0
2025

02
==�

Ld
Ldy

ollowing table is used to calculate IXX, IYY and IXY.  The values for IXX, IYY and IXY are
 in the column titled “Sum”.
Item Side 1 Side 2 Side 3 Side 4 Sum
L 49.5 25.5 49.5 25.5 N.A.
d 13.5 13.5 13.5 13.5 N.A.

x2 - x3 -12.75 0 12.75 0 N.A.
y2 - y3 0 24.75 0 24.75 N.A.
rallel to Y-Axis X-axis Y-Axis X-axis N.A.

quations 5b, 6b, 7 5a, 6a, 7 5b, 6b, 7 5a, 6a, 7 N.A.
IXX 146597 210875 146597 210875 714944
IYY 108633 23882 108633 23882 265030
IXY 0 0 0 0 0
echnical Note 1 - Punching Shear Revision 4, June 16, 2000
 Release Date: November 16, 1998 Page 9 of 31

 the SAFE output at column point 10:

 -225.707 k
 = 464.658 k-in
 = -419.712 k-in

e point labeled A in Figure 5, x4 = -12.75 and y4 = 24.75, thus:
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2
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vU = -0.111 + 0.008 - 0.007 = -0.110 ksi at point A

At the point labeled B in Figure 5, x4 = 12.75 and y4 = 24.75, thus:

2

2

)0()265030)(714944(
)]075.24)(0()075.12(714944[)]00)(707.225(712.419[324.0

)0()265030)(714944(
)]075.12)(0()075.24(265030[)]00)(707.225(658.464[482.0

5.13*150
707.225

−
−−−−−−−

−
−

−−−−−−+−=Uv

vU = -0.111 + 0.008 + 0.007 = -0.097 ksi at point B

At the point labeled C in Figure 5, x4 = 12.75 and y4 = -24.75, thus:
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vU = -0.111 - 0.008 + 0.007 = -0.113 ksi at point C

At the point labeled D in Figure 5, x4 = -12.75 and y4 = -24.75, thus:

2
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vU = -0.111 - 0.008 - 0.007 = -0.126 ksi at point D

Point D has the largest absolute value of vu, thus vmax = 0.126 ksi

The shear capacity is calculated based on the smallest of ACI 318-95 equations 11-35, 11-36 and
11-37 with the b0 and d terms removed to convert force to stress.
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Equation 11-35 yields the smallest value of  φvC = 0.179 ksi , and thus this is the shear capacity.

702.0
179.0
126.0 ===

C

U

v
vRatioShear

ϕ

6d. Hand Calculation For Edge Column With Edge Parallel To X-Axis Using SAFE
Method

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

Refer to Figure 6.

b0 = 48.75 + 25.5 + 48.75 = 123"
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The coordinates of the center of the
column (x1, y1) are taken as (0, 0).

The following table is used for
calculating the centroid of the critical section for punching shear.  Side 1 , Side 2 and Side 3 refer
to the sides of the critical section for punching shear as identified in Figure 6.
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Figure 6:  Edge Column With Edge Parallel To X-Axis,
Point 6 in SAFE Model
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3 =x

3 =y

The f
given

From

VU =
MUX
MUY

At th

Pa
E

Item Side 1 Side 2 Side 3 Sum
x2 -12.75 0 12.75 N.A.
y2 0.375 24.75 0.375 N.A.
L 48.75 25.5 48.75 b0 = 123
d 13.5 13.5 13.5 N.A.

Ld 658.125 344.25 658.125 1660.5
Ldx2 -8391.09 0 8391.09 0
Ldy2 246.80 8520.19 246.80 9013.78
"0
5.1660

02
==�

Ld
Ldx

"43.5
5.1660
78.90132

==�
Ld
Ldy

ollowing table is used to calculate IXX, IYY and IXY.  The values for IXX, IYY and IXY are
 in the column titled “Sum”.
Item Side 1 Side 2 Side 3 Sum
L 48.75 25.5 48.75 N.A.
d 13.5 13.5 13.5 N.A.

x2 - x3 -12.75 0 12.75 N.A.
y2 - y3 -5.05 19.32 -5.05 N.A.
rallel to Y-Axis X-axis Y-Axis N.A.

quations 5b, 6b, 7 5a, 6a, 7 5b, 6b, 7 N.A.
IXX 157141 128518 157141 442800
IYY 106986 23883 106986 237855
IXY 42403 0 -42403 0
echnical Note 1 - Punching Shear Revision 4, June 16, 2000
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 the SAFE output at column point 6:

 -119.738 k
 = 3778 k-in
 = -348.588 k-in

e point labeled A in Figure 6, x4 = -12.75 and y4 = 24.75, thus:
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2

2

)0()237855)(442800(
)]43.575.24)(0()075.12(442800[)]00)(119.738(588.348[325.0

)0()237855)(442800(
)]075.12)(0()43.575.24(237855[)]043.5)(119.738(3778[480.0

5.13*123
119.738

−
−−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.0721 - 0.0655 - 0.0061 = -0.144 ksi at point A

At the point labeled B in Figure 6, x4 = 12.75 and y4 = 24.75, thus:

2

2

)0()237855)(442800(
)]43.575.24)(0()075.12(442800[)]00)(119.738(588.348[325.0

)0()237855)(442800(
)]075.12)(0()43.575.24(237855[)]043.5)(119.738(3778[480.0

5.13*123
119.738

−
−−−−−−−

−
−

−−−−−−+−=Uv

vU = -0.072 - 0.065 + 0.006 = -0.131 ksi at point B

At the point labeled C in Figure 6, x4 = 12.75 and y4 = -24, thus:

2

2

)0()237855)(442800(
)]43.524)(0()075.12(442800[)]00)(119.738(588.348[325.0

)0()237855)(442800(
)]075.12)(0()43.524(237855[)]043.5)(119.738(3778[480.0

5.13*123
119.738

−
−−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.072 + 0.100 + 0.006 = 0.034 ksi at point C

At the point labeled D in Figure 6, x4 = -12.75 and y4 = -24, thus:

2

2

)0()237855)(442800(
)]43.524)(0()075.12(442800[)]00)(119.738(588.348[325.0

)0()237855)(442800(
)]075.12)(0()43.524(237855[)]043.5)(119.738(3778[480.0

5.13*123
119.738

−
−−−−−−−−−

−
−

−−−−−−−−+−=Uv

vU = -0.072 + 0.100 - 0.006 = 0.022 ksi at point D

Point A has the largest absolute value of vu, thus vmax = 0.144 ksi

The shear capacity is calculated based on the smallest of ACI 318-95 equations 11-35, 11-36 and
11-37 with the b0 and d terms removed to convert force to stress.

179.0
1000

4000
12/36

4285.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-35
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285.0
1000

40002
123

5.13*3085.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-36

215.0
1000

4000*4*85.0 ==Cvϕ  ksi per equation 11-37

Equation 11-35 yields the smallest value of  φvC = 0.179 ksi , and thus this is the shear capacity.

802.0
179.0
144.0 ===

C

U

v
vRatioShear

ϕ

6e. Hand Calculation For Edge Column With Edge Parallel To Y-Axis Using SAFE
Method

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

Refer to Figure 7.

b0 = 24.75 + 49.5 + 24.75 = 99"

485.0

75.24
5.49

3
21

11 =
�
�

�
�
�

�+
−=VXγ

320.0

5.49
75.24

3
21

11 =
�
�

�
�
�

�+
−=VYγ

The coordinates of the center of the column
(x1, y1) are taken as (0, 0).

The following table is used for calculating the
centroid of the critical section for punching
shear.  Side 1 , Side 2 and Side 3 refer to the
sides of the critical section for punching shear as identified in Figure 7.

6.
75

"
18

"
18

"
6.

75
"

6" 6" 6.75"6"

X

Y

Figure 7:  Edge Column With Edge Parallel To Y-Axis,
Point 9 in SAFE Model
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24.75"

Critical section for
punching shear
shown dashed
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de
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A B

C

Column

Edge of slab

Center of column is
point (x1, x2).  Set
this equal to (0, 0).

D
Side 3



Safe T
Initial

3 =x

3 =y

The f
given

From

VU =
MUX
MUY

At th

Pa
E

Item Side 1 Side 2 Side 3 Sum
x2 0.375 12.75 0.375 N.A.
y2 24.75 0 -24.75 N.A.
L 24.75 49.5 24.75 b0 = 99
d 13.5 13.5 13.5 N.A.

Ld 344.125 668.25 344.125 1336.5
Ldx2 125.30 8520.19 125.30 8770.78
Ldy2 8269.59 0 -8269.59 0
"56.6
5.1336
78.87702

==�
Ld
Ldx

"0
5.1336

02
==�

Ld
Ldy

ollowing table is used to calculate IXX, IYY and IXY.  The values for IXX, IYY and IXY are
 in the column titled “Sum”.
Item Side 1 Side 2 Side 3 Sum
L 24.75 49.5 24.75 N.A.
d 13.5 13.5 13.5 N.A.

x2 - x3 -6.19 6.19 -6.19 N.A.
y2 - y3 24.75 0 -24.75 N.A.
rallel to X-axis Y-Axis X-axis N.A.

quations 5a, 6a, 7 5b, 6b, 7 5a, 6a, 7 N.A.
IXX 204672.4 146597.2 204672.4 555942
IYY 34922.6 25584.1 34922.6 95429
IXY -51168 0 51168 0
echnical Note 1 - Punching Shear Revision 4, June 16, 2000
 Release Date: November 16, 1998 Page 15 of 31

 the SAFE output at column point 6:

 -94.86 k
 = 174.953 k-in
 = 1463.801 k-in

e point labeled A in Figure 7, x4 = -12 and y4 = 24.75, thus:
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2

2

)0()95429)(555942(
)]075.24)(0()56.612(555942[)]056.6)(86.49(801.1463[320.0

)0()95429)(555942(
)]56.612)(0()075.24(95429[)]00)(86.49(953.174[485.0

5.13*123
86.49

−
−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.071 + 0.004 + 0.052 = -0.015 ksi at point A

At the point labeled B in Figure 7, x4 = 12.75 and y4 = 24.75, thus:

2

2

)0()95429)(555942(
)]075.24)(0()56.675.12(555942[)]056.6)(86.49(801.1463[320.0

)0()95429)(555942(
)]56.675.12)(0()075.24(95429[)]00)(86.49(953.174[485.0

5.13*123
86.49

−
−−−−−−

−
−

−−−−−−+−=Uv

vU = -0.071 + 0.004 - 0.017 = -0.084 ksi at point B

At the point labeled C in Figure 7, x4 = 12.75 and y4 = -24.75, thus:

2

2

)0()95429)(555942(
)]075.24)(0()56.675.12(555942[)]056.6)(86.49(801.1463[320.0

)0()95429)(555942(
)]56.675.12)(0()075.24(95429[)]00)(86.49(953.174[485.0

5.13*123
86.49

−
−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.071 - 0.004 - 0.017 = 0.092 ksi at point C

At the point labeled D in Figure 7, x4 = -12 and y4 = -24.75, thus:

2

2

)0()95429)(555942(
)]075.24)(0()56.612(555942[)]056.6)(86.49(801.1463[320.0

)0()95429)(555942(
)]56.612)(0()075.24(95429[)]00)(86.49(953.174[485.0

5.13*123
86.49

−
−−−−−−−−

−
−

−−−−−−−−+−=Uv

vU = -0.071 - 0.004 + 0.052 = -0.023 ksi at point D

Point C has the largest absolute value of vu, thus vmax = 0.092 ksi

The shear capacity is calculated based on the smallest of ACI 318-95 equations 11-35, 11-36 and
11-37 with the b0 and d terms removed to convert force to stress.

179.0
1000

4000
12/36

4285.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-35
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327.0
1000

40002
99

5.13*3085.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-36

215.0
1000

4000*4*85.0 ==Cvϕ  ksi per equation 11-37

Equation 11-35 yields the smallest value of  φvC = 0.179 ksi , and thus this is the shear capacity.

515.0
179.0
092.0 ===

C

U

v
vRatioShear

ϕ

6f. Hand Calculation For Corner Column Using SAFE Method

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

Refer to Figure 8.

b0 = 24.75 + 48.75 = 73.5"

483.0

75.24
75.48

3
21

11 =
�
�

�
�
�

�+
−=VXγ

322.0

75.48
75.24

3
21

11 =
�
�

�
�
�

�+
−=VYγ

The coordinates of the center of the
column (x1, y1) are taken as (0, 0).

The following table is used for calculating the centroid of the critical section for punching shear.
Side 1 and Side 2 refer to the sides of the critical section for punching shear as identified in
Figure 8.

6"
18

"
18

"
6.

75
"

6" 6" 6.75"6"

X

Y

Figure 8:  Corner Column, Point 5 in SAFE Model
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Center of column is
point (x1, x2).  Set
this equal to (0, 0).



Safe T
Initial

3 =x

3 =y

The f
given

From

VU =
MUX
MUY

At th

Pa
E

Item Side 1 Side 2 Sum
x2 0.375 12.75 N.A.
y2 24.75 0.375 N.A.
L 24.75 48.75 b0 = 73.5
d 13.5 13.5 N.A.

Ld 334.125 658.125 992.25
Ldx2 125.30 8391.09 8516.39
Ldy2 8269.59 246.80 8516.39
"58.8
25.992
39.85162

==�
Ld
Ldx

"58.8
25.992
39.85162

==�
Ld
Ldy

ollowing table is used to calculate IXX, IYY and IXY.  The values for IXX, IYY and IXY are
 in the column titled “Sum”.
Item Side 1 Side 2 Sum
L 24.75 48.75 N.A.
d 13.5 13.5 N.A.

x2 - x3 -8.21 4.17 N.A.
y2 - y3 16.17 -8.21 N.A.
rallel to X-axis Y-Axis N.A.

quations 5a, 6a, 7 5b, 6b, 7 N.A.
IXX 87332 184673 272005
IYY 44640 11428 56069
IXY -44338 -22510 -66848
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 the SAFE output at column point 5:

 -54.696 k
 = -1962 k-in
 = 1145.68 k-in

e point labeled A in Figure 8, x4 = -12 and y4 = 24.75, thus:
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2

2

)66848()56069)(272005(
)]58.875.24)(66848()58.812(272005[)]058.8)(696.54(68.1145[322.0

)66848()56069)(272005(
)]58.812)(66848()58.875.24(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−−
−−−−−−−−

−
−−

−−−−−−−−+−=Uv

vU = -0.055 + 0.031 + 0.091 = 0.067 ksi at point A

At the point labeled B in Figure 8, x4 = 12.75 and y4 = 24.75, thus:

2

2

)66848()56069)(272005(
)]58.875.24)(66848()58.875.12(272005[)]058.8)(696.54(68.1145[322.0

)66848()56069)(272005(
)]58.875.12)(66848()58.875.24(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−−
−−−−−−−

−
−−

−−−−−−−+−=Uv

vU = -0.055 - 0.079 - 0.045 = -0.179 ksi at point B

At the point labeled C in Figure 8, x4 = 12.75 and y4 = -24, thus:

2

2

)66848()56069)(272005(
)]58.824)(66848()58.875.12(272005[)]058.8)(696.54(68.1145[322.0

)66848()56069)(272005(
)]58.875.12)(66848()58.824(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−−
−−−−−−−−

−
−−

−−−−−−−−+−=Uv

vU = -0.055 + 0.104 + 0.021 = 0.070 ksi at point C

Point B has the largest absolute value of vu, thus vmax = 0.179 ksi

The shear capacity is calculated based on the smallest of ACI 318-95 equations 11-35, 11-36 and
11-37 with the b0 and d terms removed to convert force to stress.

179.0
1000

4000
12/36

4285.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-35

404.0
1000

40002
5.73

5.13*2085.0
=

�
�

�
�
�

� +
=Cvϕ  ksi per equation 11-36

215.0
1000

4000*4*85.0 ==Cvϕ  ksi per equation 11-37

Equation 11-35 yields the smallest value of  φvC = 0.179 ksi , and thus this is the shear capacity.
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000.1
179.0
179.0 ===

C

U

v
vRatioShear

ϕ

6g. Hand Calculation For Corner Column Using SAFE Method Except That IXY Is Set To
Zero

This calculation is done for comparison with the corner calculation using the PCA Publication
method (Ref. 2).  Note that the computer program SAFE does not do the calculation with IXY set
to zero.

The calculations in this case are exactly the same as in Section 6f, except that IXY is set to zero.
Thus, using the intermediate results in Section 6f we can go right to calculating the stresses.

At the point labeled A in Figure 8, x4 = -12 and y4 = 24.75, thus:

2

2

)0()56069)(272005(
)]58.875.24)(0()58.812(272005[)]058.8)(696.54(68.1145[322.0

)0()56069)(272005(
)]58.812)(0()58.875.24(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−
−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.055 - 0.043 + 0.080 = -0.018 ksi at point A

At the point labeled B in Figure 8, x4 = 12.75 and y4 = 24.75, thus:

2

2

)0()56069)(272005(
)]58.875.24)(0()58.875.12(272005[)]058.8)(696.54(68.1145[322.0

)0()56069)(272005(
)]58.875.12)(0()58.875.24(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−
−−−−−−

−
−

−−−−−−+−=Uv

vU = -0.055 - 0.043 - 0.016 = -0.114 ksi at point B

At the point labeled C in Figure 8, x4 = 12.75 and y4 = -24, thus:

2

2

)0()56069)(272005(
)]58.824)(0()58.875.12(272005[)]058.8)(696.54(68.1145[322.0

)0()56069)(272005(
)]58.875.12)(0()58.824(56069[)]058.8)(696.54(1962[483.0

5.13*5.73
696.54

−
−−−−−−−

−
−

−−−−−−−+−=Uv

vU = -0.055 + 0.086 - 0.016 = 0.015 ksi at point c

Point B has the largest absolute value of vu, thus vmax = 0.114 ksi
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6h. Terminology For PCA Publication Method of Calculating Punching Shear

a = Distance from center of column to centroid of critical section for punching shear
AC = Area of critical section for punching shear
b1 = Length of side of critical section for punching shear parallel to Y-axis for

bending about X-axis, and parallel to the X-axis  for bending about Y-axis
b2 = Length of side of critical section for punching shear parallel to X-axis for

bending about X-axis, and parallel to the Y-axis  for bending about Y-axis
c = For bending about the X-axis, shorter Y distance from centroid of critical

section for punching shear to an edge of the critical section for punching shear
that is parallel to the Y-axis.  For bending about the Y-axis, shorter X distance
from centroid of critical section for punching shear to an edge of the critical
section for punching shear that is parallel to the X-axis.

c' = For bending about the X-axis, longer Y distance from centroid of critical section
for punching shear to an edge of the critical section for punching shear that is
parallel to the Y-axis.  For bending about the Y-axis, longer X distance from
centroid of critical section for punching shear to an edge of the critical section
for punching shear that is parallel to the X-axis.

J/c = Section modulus associated with critical section for punching shear
J/c' = Section modulus associated with critical section for punching shear
MUX = Moment about line parallel to X-axis at center of column or load
MUY = Moment about line parallel to Y-axis at center of column or load
MUXtransformed = Moment about line parallel to X-axis at centroid of critical section for punching

shear
MUYtransformed = Moment about line parallel to Y-axis at centroid of critical section for punching

shear
γ = Percent of MUX resisted by shear per ACI 318-95 equations 11-41 and 13-1

6i. Basic Equation For PCA Publication Method

The basic equation for the PCA Publication method is:

Y

YmedUYtransforVY

X

XmedUXtransforVX

C

U
U

J
CM

J
CM

A
Vv

γγ
++= Eq. 8

Depending on the corner of the critical section for punching shear where you are calculating
stress this equation may be in one of the following forms:

Y

YmedUYtransforVY

X

XmedUXtransforVX

C

U
U

J
CM

J
CM

A
Vv

'' γγ
−−= Eq. 9

Y

YmedUYtransforVY

X

XmedUXtransforVX

C

U
U

J
CM

J
CM

A
Vv

γγ
+−=

'
Eq. 10
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Y

YmedUYtransforVY

X

XmedUXtransforVX

C

U
U

J
CM

J
CM

A
Vv

'γγ
−+= Eq. 11

6j. Hand Calculation For Interior Column Using PCA Publication Method

From the SAFE computer output given
in Figure 4 for Point:

VU = --225.707 k (upward positive)
MUX = 464.658 k-in (right-hand rule)
MUY = -419.712 k-in (right-hand rule)

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

To calculate data for bending about X-
axis refer to Figure 9.  Note that the
direction and sign of MUX shown in
Figure 15 is consistent with that given
in the SAFE output.

b1 = 49.5"
b2 = 25.5"

482.0

5.25
5.49

3
21

11 =
�
�

�
�
�

�+
−=VXγ

AC = 2(b1 + b2)d = 2 * (49.5 + 25.5) * 13.5 = 2025 in2

3
33

211 6.28886
3

5.13))5.25*3(5.49(5.13*5.49
3

)3( indbbdb
c
J

X

X =++=++=

3
33

211 6.28886
3

5.13))5.25*3(5.49(5.13*5.49
3

)3(
'

indbbdb
c
J

X

X =++=++=

"75.24
2
5.49

2
1 === bcX

"75.24
2
5.49

2
' 1 === bc x

MUXtransformed = MUX = 464.658 k-in (direction of moment shown in Figure 9)
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"
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"
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Figure 9:  Interior Column, Point 10 in SAFE Model
Bending About X-Axis
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To calculate data for bending about Y-axis refer
to Figure 10.  Note that the direction and sign of
MUY shown in Figure 10 is consistent with that
given in the SAFE output.

b1 = 25.5"
b2 = 49.5"

324.0

5.49
5.25

3
21

11 =
�
�

�
�
�

�+
−=VYγ

3
33

211 6.20786
3

5.13))5.49*3(5.25(5.13*5.25
3

)3( indbbdb
c
J

Y

Y =++=++=

3
33

211 6.20786
3

5.13))5.49*3(5.25(5.13*5.25
3

)3(
'

indbbdb
c
J

y

y =++=++=

"75.12
2
5.25

2
1 === bcY

"75.12
2
5.25

2
' 1 === bc x

MUYtransformed = MUY = 419.712 k-in (direction of moment shown in Figure 10)

The punching shear stress at point A in Figures 9 and 10 is calculated using equation 10:

ksivU 110.0007.008.111.0
6.20786

712.419*324.0
6.28886

658.464*482.0
2025

707.225 =+−=+−=

The punching shear stress at point B in Figures 9 and 10 is calculated using equation 9:

ksivU 096.0007.008.111.0
6.20786

712.419*324.0
6.28886

658.464*482.0
2025

707.225 =−−=−−=

The punching shear stress at point C in Figures 9 and 10 is calculated using equation 11:
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Figure 10:  Interior Column, Point 10 in SAFE Model
Bending About Y-Axis
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ksivU 112.0007.008.111.0
6.20786

712.419*324.0
6.28886

658.464*482.0
2025

707.225 =−+=−+=

The punching shear stress at point D in Figures 9 and 10 is calculated using equation 8:

ksivU 126.0007.008.111.0
6.20786

712.419*324.0
6.28886

658.464*482.0
2025

707.225 =++=++=

Point D has the largest absolute value of vu, thus vmax = 0.126 ksi

6k. Hand Calculation For Edge Column With Edge Parallel To X-Axis Using PCA
Publication Method

From the SAFE computer output
given in Figure 4 for Point 6:

VU = -119.738 k (upward positive)
MUX = -3778 k-in (right-hand rule)
MUY = -348.588 k-in (right-hand rule)

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

To calculate data for bending about
X-axis refer to Figure 11.  Note that
the direction and sign of MUX shown
in Figure 11 is consistent with that
given in the SAFE output.  Also note
that X-direction bending is bending
perpendicular to the edge.
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Figure 11:  Edge Column With Edge Parallel To X-Axis 
Point 6 in SAFE Model, Bending About X-Axis
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aX = 18 + 6.75 - 19.32 = 5.43"

MUXtransformed = 3778 - 119.738 * 5.43 = 3128 k-in (direction of moment shown in Figure 11)

To calculate data for bending about Y-axis refer
to Figure 12.  Note that the direction and sign of
MUY shown in Figure 12 is consistent with that
given in the SAFE output.  Also note that Y-
direction bending is bending parallel to the edge.
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Figure 12:  Edge Column With Edge Parallel To X-Axis
Point 6 in SAFE Model, Bending About Y-Axis
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MUYtransformed = MUY = 348.588 k-in (direction of moment shown in Figure 12)

The punching shear stress at point A in Figures 11 and 12 is calculated using equation 8:

ksivU 144.0006.066.072.0
3.18655

588.348*325.0
3.22917

3128*480.0
5.1660

738.119 =++=++=

The punching shear stress at point B in Figures 11 and 12 is calculated using equation 11:

ksivU 132.0006.066.072.0
3.18655

588.348*325.0
3.22917

3128*480.0
5.1660

738.119 =−+=−+=

The punching shear stress at point C in Figures 11 and 12 is calculated using equation 9:

ksivU 034.0006.100.072.0
3.18655

588.348*325.0
7.15046

3128*480.0
5.1660

738.119 −=−−=−−=

The punching shear stress at point D in Figures 11 and 12 is calculated using equation 10:

ksivU 022.0006.100.072.0
3.18655

588.348*325.0
7.15046

3128*480.0
5.1660

738.119 −=+−=+−=

Point A has the largest absolute value of vu, thus vmax = 0.144 ksi

6l. Hand Calculation For Edge Column With Edge Parallel To Y-Axis Using PCA
Publication Method

From the SAFE computer output given in Figure 4 for Point 9:

VU = -94.86 k (upward positive)
MUX = 174.953 k-in (right-hand rule)
MUY = 1463.801 k-in (right-hand rule)

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

To calculate data for bending about X-axis refer to Figure 13.  Note that the direction and sign of
MUX shown in Figure 13 is consistent with that given in the SAFE output.  Also note that X-
direction bending is bending parallel to the edge.



Safe Technical Note 1 - Punching Shear Revision 4, June 16, 2000
Initial Release Date: November 16, 1998 Page 27 of 31

b1 = 49.5"
b2 = 24.75"

485.0

75.24
5.49

3
21

11 =
�
�

�
�
�

�+
−=VXγ

AC = (b1 + 2b2)d
= (49.5 + (2 * 24.75)) * 13.5
= 1336.5 in2

3
33

211 3.22462
6

5.13))75.24*6(5.49(5.13*5.49
6

)6( indbbdb
c
J

X

X =++=++=

3
33

211 3.22462
6

5.13))75.24*6(5.49(5.13*5.49
6

)6(
'

indbbdb
c
J

X

X =++=++=

"75.24
2
5.49

2
1 === bcX

"75.24
2
5.49

2
' 1 === bc X

MUXtransformed = MUX = 174.953 k-in (direction of
moment shown in Figure 13)

To calculate data for bending about Y-axis refer
to Figure 14.  Note that the direction and sign of
MUY shown in Figure 14 is consistent with that
given in the SAFE output.  Also note that Y-
direction bending is bending perpendicular to
the edge.
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Figure 13:  Edge Column With Edge Parallel To Y-Axis 
Point 9 in SAFE Model, Bending About X-Axis
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Figure 14:  Edge Column With Edge Parallel To Y-Axis
Point 6 in SAFE Model, Bending About Y-Axis
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aY = 6 + 6.75 - 6.19 = 6.56"

MUYtransformed = 1463.801 - 94.86 * 6.56 = 841 k-in (direction of moment shown in Figure 14)

The punching shear stress at point A in Figures 13 and 14 is calculated using equation 9:

ksivU 015.0052.004.071.0
0.5141
841*320.0

3.22462
953.174*485.0

5.1336
86.94 =−−=−−=

The punching shear stress at point B in Figures 13 and 14 is calculated using equation 10:

ksivU 084.0017.004.071.0
9.15422

841*320.0
3.22462
953.174*485.0

5.1336
86.94 =+−=+−=

The punching shear stress at point C in Figures 13 and 14 is calculated using equation 8:

ksivU 092.0017.004.071.0
9.15422

841*320.0
3.22462
953.174*485.0

5.1336
86.94 =++=++=

The punching shear stress at point D in Figures 13 and 14 is calculated using equation 11:

ksivU 023.0052.004.071.0
0.5141
841*320.0

3.22462
953.174*485.0

5.1336
86.94 =−+=−+=

Point C has the largest absolute value of vu, thus vmax = 0.092 ksi
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6m. Hand Calculation For Corner Column Using PCA Publication Method

From the SAFE computer output given
in Figure 4 for Point 5:

VU = -54.696 k (upward positive)
MUX = -1962 k-in (right-hand rule)
MUY = 1145.68 k-in (right-hand rule)

d = [(15 - 1) + (15 - 2)] / 2 = 13.5"

To calculate data for bending about X-
axis refer to Figure 15.  Note that the
direction and sign of MUX shown in
Figure 15 is consistent with that given
in the SAFE output.
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Figure 15:  Corner Column, Point 5 in SAFE Model
Bending About X-Axis

b 1
 =

 4
8.

75
"

b2 = 24.75"

Critical section for
punching shear
shown dashed

A B

C

Column

Edge of slab

c'
 =

32
.5

8"
c 

= 
16

.1
7"

MUX = 1962 k-in

MUXtransformed = 1493 k-in

a 
=8

.5
8"



Safe Technical Note 1 - Punching Shear Revision 4, June 16, 2000
Initial Release Date: November 16, 1998 Page 30 of 31

MUXtransformed = 1962 - 54.696 * 8.58 = 1493 k-in (direction of moment shown in Figure 15)

To calculate data for bending about Y-axis refer
to Figure 16.  Note that the direction and sign of
MUY shown in Figure 16 is consistent with that
given in the SAFE output.
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aY = 6 + 6.75 - 4.17 = 8.58"

MUYtransformed = 1145.68 - 54.696 * 8.58 = 676 k-in (direction of moment shown in Figure 16)

The punching shear stress at point A in Figures 15 and 16 is calculated using equation 11:
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Figure 16:  Corner Column, Point 5 in SAFE Model
Bending About Y-Axis
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ksivU 018.0080.043.055.0
0.2724
676*322.0

6.16824
1493*483.0

25.992
696.54 =−+=−+=

The punching shear stress at point B in Figures 15 and 16 is calculated using equation 8:

ksivU 114.0016.043.055.0
1.13455

676*322.0
6.16824

1493*483.0
25.992

696.54 =++=++=

The punching shear stress at point C in Figures 15 and 16 is calculated using equation 10:

ksivU 018.0016.086.055.0
0.2724
676*322.0

1.8348
1493*483.0

25.992
696.54 −=+−=+−=

Point B has the largest absolute value of vu, thus vmax = 0.114 ksi

6n. Comparison Of Punching Shear Stress Results

A comparison of the punching shear stress results is shown in the table below.  The hand
calculations using the SAFE method yield results the same as the SAFE computer model for all
cases, that is for the interior column, the edge column with the edge parallel to the X-axis, the
edge column with the edge parallel to the Y-axis and the corner column.  The hand calculations
using the PCA Publication method (Ref. 2) yield results the same as the SAFE computer model
(and SAFE hand calculations) for all cases except the corner column.  For the corner column if
the IXY term in the hand calculations using the SAFE method is set to zero, then this calculation
yields the same result as the hand calculation using the PCA method.

Punching Shear Stress Results, ksi

Column Type
SAFE Computer

Model

Hand Calculation
Using SAFE

Method

Hand Calculation
Using PCA

Publication Method
Interior 0.126 0.126 0.126
Edge parallel to X-axis 0.144 0.144 0.144
Edge parallel to Y-axis 0.144 0.144 0.144
Corner 0.179 0.179 0.114
Corner with IXY = 0 N. A. 0.114 N. A.


